
Cambria Live Series 5.3                                     Release Notes (07/01/2024) 
Release Build: 5.3.0.x 
Release Notes covers Cambria Live, Broadcast Manager, Live Editor 
 
Important notes about the PostgreSQL upgrade (for Broadcast Manager users only): 

 Database migration between Postgres 9.3 and 14.3 is not automatic 
 Installing BCM ver. 5.0 will come with a clean Database (Postgres 14.3) 
 If you are upgrading from BCM version 4.8 (or lower) to BCM 5.0 then Postgres 9.3 will still be 
installed on the system, which will be used to migrate all of the information to Postgres 14.3 
 Only migration from Postgres 9.3 (BCM versions 4.8 or lower) to Postgres 14.3 (BCM 5.0 and 
above) is supported. 
 Please read the migration document below on how to migrate the database:  
https://www.dropbox.com/s/qraoi0ye06f9t85/Postgres%2014.3%20Migration%20Document_BCM.pdf?dl=0 
 

System Requirements 

Required Operating System Windows 10, Windows 11, Windows Server 2016/2019/2022  
(Windows should be updated through Microsoft Windows 
Update before installing the application) 

Motherboard 1 USB port for the USB license key (optional for USB license 
method) 
1 PCIe slot for each capture card (optional for capture input) 
1 PCIe slot for the External Signal Input card (optional for source 
switching automation)  

 

Cambria Live Benchmarks 

Real-time Performance Benchmarks: 
Cambria Live projects can be configured in very many ways, each with different requirements 
on resource usage.  The two benchmark configurations detailed in this section are run using 
the same hardware configuration and can provide some insight to if other configurations can be 
run successfully in real-time. 
Machine Configuration: HP Z4 

Operating System Windows 10 SP1 64-bit 

Processor Intel Core i7-7820X @ 3.60GHz (8-core Skylake X) 

Memory 16 GB 

PCIe Slot for Capture 
Board 

Slot 3 (https://www.aja.com/support/kona-pc-system-
configuration) 



Benchmark Configuration 1: HD I/O no Source Switching 
H.264, CPU only 
 
Two types of projects were tested.  One includes one 1080p SDI input and one 1080p RTMP 
output stream.  The second project has one 1080p SDI input and one Adaptive Streaming 
output with 4 video layers (1080p/720p/480p/360p)   

HD I/O no Source Switching 

RTMP output stream (1080p) 4 simultaneous projects on HP Z4 

Adaptive Streaming: 4 video layers 
(1080p/720p/480p/360p)   

2 simultaneous projects on HP Z4 
*** “Use only physical CPU cores” must be 
disabled to maintain real-time speed 

 
Note: Testing was done without any source switching.  Each SDI input was mapped to 
a different target output through the target ISO stream setting.  Basic source 
properties and target settings such as frame size, frame rate, and aspect ratio are 
matched.  Fast encoding settings consistent with our Live Streaming presets were 
used. 
 

H.264 and HEVC, NVIDIA NVENC Accelerated 
 

HD I/O no Source Switching 

RTMP output stream (1080p) 4 simultaneous projects (HEVC or H.264) 
on HP Z4 
 

Adaptive Streaming: 4 video layers 
(1080p/720p/480p/360p)   

2 simultaneous projects (HEVC or H.264) 
on HP Z4 
 
 

 
Note: Testing was done without any source switching.  Each SDI input was mapped to 
a different target output through the target ISO stream setting.  Basic source 
properties and target settings such as frame size, frame rate, and aspect ratio are 
matched.  Fast encoding settings consistent with our Live Streaming presets were 
used. 

 



Benchmark Configuration 2: Mixed Source Composition Switching 
H.264, CPU only 
 
Project includes compositions created from 1080p Signal Input, Virtual Cameras, Picture-in-
Picture, and Layer sources.  Real-time performance is maintained when switching between 
these compositions and the program output is encoded to a 1080p, 480p, 360p, 240p output. 

Mixed Source Composition Switching 

Capture Signal Input (1080p30) 1 x HD input 

Virtual Cameras 5 

Picture-in-Pictures 5 (2 using Videos with Alpha Layers)  

Layers 5 

Target Streams  1 x HD and 3 x SD streams 

Note: Fast encoding settings consistent with our Live Streaming presets were used. 

  
 
 

Performance Considerations 

Performance Indicators:  
Adding additional targets or modifying encoding settings can affect the application’s ability to 
maintain real-time performance. For every target, there are indicators for Processing Speed and 
Delivering Speed.  These indicators along with the CPU Usage (found in the lower left of the 
application) can be used to gauge Cambria Live’s real-time performance.  We recommend that 
users configure and test their Cambria Live projects prior to streaming Live.  The indicators will 
be Green when the real-time speed is maintained, and will become yellow or red when real-
time speed cannot be maintained.  When real-time speed is not maintained dropped frames 
or stream disconnect can occur.    
 
Optimization: 
Targets outputting to different destinations but using the same exact encoding settings as an 
already existing target will be able to share the same encoding mappings.  This will allow you 
to encode to more target destinations without increasing the CPU load by much.   
 
Quad-Channel Memory Optimization:  
We recommend that you use a Quad-Channel Memory configuration, if your computer supports 
it.  This will reduce the chances of running into memory bandwidth bottlenecks.  



2560x1440 Resolution and 60fps Setting 
Targets that are either 2560x1440 or 60fps will use more system resources than 1080p 30fps 
targets.  The benchmarks shown in the previous section are only for 1080p 30fps targets. 
 
Staging Preview / Program Output Refresh Rate: 
Performance of Live instances is affected by the staging preview / program output refresh rate. 
The lower the refresh rate, the less processing power each Live instance will use on your 
machine.  You can lower the refresh rate to a lower level to increase performance.  You can 
set it to OFF if the preview is not important to your workflow. 
 
Windows Virtual Memory Setting: 
To prevent some memory allocation errors that can occur, we recommend changing a Windows 
Virtual Memory setting to allow for “System managed size”. 
  a. Open up to the Advanced tab in the System Properties panel 
    (Control Panel>System and Security>System>Advanced system settings) 
  b. Select Settings under Performance 
  c. From the Advanced tab select Change under Virtual Memory 
  d. Uncheck “Automatically manage paging file size for all drives”, select “System managed 
    size”   
 

Recommended System for Cambria Live and Broadcast Manager 

System Recommendation: 
This is the recommended configuration for both a Cambria Live (only) system and also for a 
Broadcast Manager installation that includes Cambria Live on the same machine.  It is also 
recommended that the same Cambria build versions are for BCM and for Live. 
 

(Cambria Live only) or (Cambria Live + BCM)  

Model HP Z4 

Operating System Windows 10 SP1 64-bit 

Processor Intel Core i7-7820X @ 3.60GHz (8-core Skylake X) 

Memory 16 GB 

Video Card Supports Direct3D acceleration 

Network Adapter Gigabit Ethernet (Wired Connection) 

System Hard Drive SSD (256 GB) 

  



Broadcast Manager Test Configuration 

Testing Limits: 
The table below shows the maximum number of machines and programs that we have tested 
for Broadcast Manager and Cambria Live configuration.   
 

BCM + Live; Configuration  

Number of BCM machines 2 (Primary and Backup) 

Number of Live machines 5  

Number of concurrent 
programs 

22 SD (480p30) or 12 HD (720p30) programs   
 

 



New Features and Major Changes:  
 
 

New Features/Changes for Live and BCM (For 5.3)  
 
Module Feature Capella 

Reference # 
Source Cambria Live RTMP MediaRouter Capture Source Added 

 
Cambria Live has a built-in media router that allows for all input 
streams to be sent to the same port (eg 1935) on the same 
machine.  The media router will then route the streams to a 
specific Cambria Live instance running on that machine using the 
Stream Name specified in the input. 
 
Incoming RTP streams will have a port and stream name: 
(eg rtmp://127.0.0.1:1935/live/[Stream Name]) 
 
Cambria Live projects can be configured to accept this stream via 
the Media Router.  In the project’s RTMP (via Media Router) 
Capture Source settings you can configure it to take in the 
specified stream by configuring the RTMP Port and Stream Name 
settings.  
 

17024 

Source Restrict certain sources from being manually selected for 
streaming 
 
In Cambria Live, sources have a new right-click (context) 
checkbox, "Set as Streaming Restricted Source", which disables 
the source for being selected for streaming purposes. This way, 
users can avoid clicking or switching to this source accidently 
(when it is not meant to be used as a streaming source).  An 
example of this is a source to be used as an automated Ad Slate, 
Sponsor Slate, or Preroll Source. 
 
Notes: 
- Enabling "Use Fail-over" or "Set as Default Source" will disable 
the "Set as Streaming Restricted Source" as the former options 
are for streaming sources. 
- Multiple sources can be selected as "Set as Streaming 
Restricted Source".  
 

19435 

Target (DRM) Axinom DRM Support Added 
 
Link to help documentation: 
https://www.dropbox.com/scl/fi/vai90mc4ziw6n6vubz41m/Cambria-
Axinom-Integration-User-
Guide.pdf?rlkey=9dgyl0n9hyx5g1wnr2vcxrpnl&st=l6t28v8q&dl=0 
 

19449 

Target 
(Generate 
Thumbnails) 

Generate Output Thumbnails of Program  
 
Thumbnail files can be generated from the Program output and 
written to an output folder location.  Settings can be found under 
the Option (tab) in Cambria Live.   
 

18903 

https://www.dropbox.com/scl/fi/vai90mc4ziw6n6vubz41m/Cambria-Axinom-Integration-User-Guide.pdf?rlkey=9dgyl0n9hyx5g1wnr2vcxrpnl&st=l6t28v8q&dl=0
https://www.dropbox.com/scl/fi/vai90mc4ziw6n6vubz41m/Cambria-Axinom-Integration-User-Guide.pdf?rlkey=9dgyl0n9hyx5g1wnr2vcxrpnl&st=l6t28v8q&dl=0
https://www.dropbox.com/scl/fi/vai90mc4ziw6n6vubz41m/Cambria-Axinom-Integration-User-Guide.pdf?rlkey=9dgyl0n9hyx5g1wnr2vcxrpnl&st=l6t28v8q&dl=0


 
 

New Features/Changes for Live and BCM (For 5.2)  
 
Module Feature Capella 

Reference # 
Source Zixi capture support added 

 
Zixi input only works if input signal comes from a Zixi 
Broadcaster. 
 
Note: Zixi capture support does not include receiving Zixi output 
from another Cambria Live.   
 

17921 

Target Embed ARIB STD B-37 in ARIB STD B-40 format to target  
 
Capturing ARIB STD B-37 data from SDI's VANC input and embed 
to TS-based streams based on ARIB STD B-40 spec. Target TS-
based streams: TS File, RTP/TS, SRT/TS, Zixi/TS.  Configuration 
can be found under the options tab. 
 

18508 

Target (Unified 
Streaming) 

Enhancements for Unified Streaming targets  
 
- Adaptive Streaming targets HLS/DASH/CMAF are now able to 
have multiple audio tracks with the same bitrate.  This is mainly 
used for role-based cases where for example, 1 audio track is 
English and another audio track is Spanish, but both need to be 
on the same bitrate. 
 
- For USP, we now support 'kind' box which is used for 
embedding audio roles in ABR streams. 
 
- In the CMAF target under the Unified Streaming type, there is 
now a checkbox that allows sending an end of stream (EOS) 
signal to the Unified Streaming origin so as to stop the endpoint 
from being active. 
 
 

18051, 
18037, 
18036 
 

Target MPEG-1 Audio Layer II added to RTP target 
 

18261 

Target Twitter notifications in Cambria Live UI removed 
 

18582 
 

Module / 
components 

Skaarhoj integration enhancement 
 
Number of possible assigned sources increased from 9 to 16. 
  

18551 



 

New Features/Changes for Live and BCM (For 5.1)  
 
Module Feature Capella 

Reference # 
Source  “Web” capture source added 

 
Added a new capture source called "Web" which allows the users 
to input an Address (URL) to display a website in Read-Only or to 
display a website template. 
 

17418 

Target (ABR) Unified Streaming added to ‘Upload Target’ setting for 
CMAF (Upload) targets 
 

17973 
 

Target (Audio) HE-AAC audio added 
 
HE-AACv1 was added these targets (File, RTP, SRT, Zixi, 
CMAF/DASH/HLS). 
 

17581 

Target (Dolby 
Audio) 

Dolby Digital and Dolby Digital Plus Encoding 
 
 

17151, 
17075 

Target 
(YouTube) 

YouTube Live API in BCM 
 
Allows for removing YouTube Programs with BCM.  Can be done 
through the BCM Desktop GUI or through REST API 
(REST_API_BroadcastAndPackagerManager 1.7.pdf) 
 

16775 

Target 
(Icecast) 

Icecast Target added 
 

17250 

Target  EBP marker support 
 
Transport Stream EBP markers can be embedded into output TS 
streams.  This is enabled through the ‘Options’ tab setting, 
‘Embed EBP markers to Transport Stream’. 
 

17312 

Ad Insertion 
(GOP 
handling) 

Sustain GOP Structure with Splice Point 
 
Under ‘Options’ dropdown there is a new setting called “Sustain 
GOP Structure with Splice Point”.  When this setting is ON, the 
output GOP structure will be sustained even if a key frame of ad 
start/end point is inserted. 
 

17336 

Ad Insertion 
(WebUI) 

Ad Break Controller (WebUI) 
 
A WebUI has been added for Ad Break Controller to allow users to 
use a web interface for manual add insertion workflows. 
 

17832 

Optimization Optimization for multiple processor machines 
 
Under ‘Options’ dropdown there is a new setting called “Use 
Multiple Processor Optimization”.  When this is set to on, 
Cambria Live instances launched on the same machine will use 
alternating NUMA nodes.  This allows for a more reliable 
percentage of CPU resource to be dedicated to each instance. 
   

17457 



Plugin Linear Streaming Plugin 
 
This plugin supports 24/7 streaming with dynamic loop 
adjustment based on xml changes. Previously, with Program Loop 
workflow, users were restricted to a loop time specified prior to 
event time. This loop time could not be adjusted after streaming 
has started. Now with the Linear streaming plug in, users are 
able to specify the loop times on the go and adjust accordingly 
based on the incoming clips.  
 

17543, 
17542 



 

New Features/Changes for Live and BCM (For 5.0)  
 
Module Feature Capella 

Reference # 
Source (RTP / 
SRT) 

Latency handling added to RTP and SRT Capture Sources 
 
RTP and SRT capture sources now have a dropdown under 
"Capture Settings" to specify the type of latency to apply to the 
capture source. 
 
Options: 
1. Low latency (reduce the latency between receiver and sender but 
packet receive strategy is stricter) 
2. Normal latency (normal latency between receiver and sender 
based on network) 
3. Prioritize Stability (increase latency between receiver and sender 
but stability of stream will be improved) 
 

17267 

Source Continue to use last available source frame when source signal 
is disconnected  
 
When the input source has no signal, due to disconnection etc., the 
default behavior is to use a black frame.  An option has been 
added to allow for the last source frame to be used instead. 
 
Frame shown when capture signal lost can be found in Cambria 
Live App under the ‘Target’ settings dropdown. 
 

16965 

Source Rotation option added to flip/rotate Sources 
 
Rotation setting can be found in Video Control (tab).  Can be set 
for any source. 
 

17087 

Source / 
Target 
 
 

Support for subtitle handling (conversion) from RTP/SRT 
capture source to ABR target with WebVTT captions 
 
A checkbox that was added to the ‘Option’ drop down menu that 
allows for the user to capture the subtitle source using RTP/SRT 
inputs and ABR outputs. Recommended that ‘Latency Mode’ is set 
to "Prioritize Stability" to avoid any frame drops. 
 

17268 

Target Improved Encoder Sharing Optimization 
 
It is now possible for HLS interleave, RTP, RTMP, SRT, and File 
targets to share encoders. All targets must share encoding 
settings which include: 
Frame rate, frame size, GOP size, bitrate, interlacing, aspect 
ratio, codec, etc.  Both video and audio encoding settings need 
to match between targets  
 
To guarantee settings matches, use the preset import / export 
feature in the encoding settings to sync the encoding settings 
between different targets. 
 
Notes: Encoding settings can be imported from HLS interleave to 

16927 



the other targets but not the other way around 
 

Target (Audio) 
 

Target side audio channel mapper added for CMAF, MPEG-
DASH, HLS.   
 
In the Target select the ‘Specify audio channel to use’ checkbox 
in the audio settings.  For CMAF, MPEG-DASH, HLS targets only. 
 
Note: For HLS only non-interleave output supports multiple audio 
tracks. 
 

17167 

Target (Audio) (Beta) 7.1 audio support  
 
A 7.1 option has been added in the ‘Audio Stream Configuration’ 
section under ‘Number of Channels’ for CMAF, MPEG-DASH, HLS 
targets. 
 
Note: Inclusion of this feature is to allow for external testing, 
please do not use this in production. 
 

17167, 
17305 

Target (Audio) Multiple Audio Track Support for CMAF, MPEG-DASH, HLS 
 
Note:  Multiple Audio Tracks with HLS is not supported  
 

17168 

Module / 
components 
(BCM only) 

PostgreSQL version updated to 14.3 
 
Postgres is used by BCM has been updated to 14.3 from 9.3.2. 
 
Notes:   
- Installing Postgres 14.3 does not replace/remove old 9.3.2. 
Users can remove old version once they migrated.  However, 
make sure that old database information is migrated properly. 
 
- New Postgres 14.3 is not a seamless upgrade and require user 
actions. User is expected to run "PostgreSQLUpdater" to clone old 
database to new database (migration). 
Migration doc link:  
https://www.dropbox.com/s/qraoi0ye06f9t85/Postgres%2014.3%20Migration%20Do
cument_BCM.pdf?dl=0 
 
- User may not setup Redundancy across different Postgres 
versions. 

16347, 
16972 

Module / 
components 

Single project can support Multiple Skaarhoj controllers 
 
Multiple Skaarhoj controllers can be connected to a single project.  
Example use case: Each Skaarhoj switcher can be placed in a 
different studio locations but controlling the same live event.  
 
 
 
 

17118 



 

New Features/Changes for Live and BCM (For 4.8)  
 
Module Feature Capella 

Reference # 
Source Input stream syncing based on timecode   

 
A checkbox has been added in the ‘Options’ tab for “Use Sync 
Sources”.  In addition, the user can adjust the Max Buffer size. 
 
Input signals will also need to be marked as a “Automatic Synced 
Source”, this is done through the right-click menu. 
 
Notes: 
- Timecode handling needs to be enabled to use this feature. 
- Syncing will apply to both PiPs and VCs of the input source. 
- Tested input source is RTMP but the feature can be used with 
any source that uses timecode. 
- All incoming sources need to have the same frame rate. 
- Frame rate of the project needs to match the incoming frame 
rate of the source. 
- Optional purchase license required.  
 
Logic/Limitations: 
-All sources marked with Automatic Synced Source will be 
synced. 
-Live will pick one source as "Master" (which is first come first 
serve basis) 
-Then try to sync other sources against "Master" source based on 
timecode 
-Since some source can be arrived later or earlier than "Master" 
source, some sources will synced to negative (make it faster) or 
positive (make it slower) direction 
-In order to do so, Live will at first start buffering incoming signal 
from each sources (so each sources can be adjusted 
negative/positive direction) [initial buffering] 
-The amount of initial buffering is the half size of Max Buffer (ms) 
setting, so when this feature is turned on, Automatic Synced 
Sources will be delayed that much. 
-Since uncompressed video/audio will be cached, it can consume 
a noticeable amount of memory. 
 

16286 

Source Ignore option for ‘No Signal’ for Capture input 
 
In Cambria Live under Assets > Fail-over for lost Capture signal, 
there is now an option "Do Nothing" in which Cambria Live does not 
disable active capture sources / pips that have lost signal. 
 

16359 

Source In Cambria Live, you can now designate one capture source to be 
a failover source. Similar to setting a regular failover source, a 
user can right click on a source and select "Use as failover source 
(capture)". 
 
Note: Hierarchy of sources: 1. Default Source 2. Failover Source 
(Capture) 3. Failover Source (Non-Capture). Switching should 
happen in that order. 
 

16299 



Target GPU Acceleration for HEVC and H.264 Targets 
 
New video encoder option added for NVENC HEVC and H.264   
 
Performance: 
Quality, Speed, and Number of Concurrent encodes are limited by 
the type of Nvidia GPU used.  List of features that are influenced 
by GPU type:  
  
1: Number of GPUs supported on a single machine  
2: Number of concurrent NVENC encodings  
3: HEVC B Frame support (B frame in GOP structure)  
4: Processing speed of a NVENC encode  
 
7th NVENC Generation (or newer) *Qualified* GPUs are 
recommended for better performance and least limitations.  For 
a list of GPUs, please visit 
https://developer.nvidia.com/videoencode-and-decode-gpu-
support-matrix-new  
  
The only officially supported card (Capella tested):   
PNY NVIDIA Quadro RTX 4000  
*Qualified* GPU  
  
Benchmark: PNY NVIDIA Quadro RTX 4000 (Machine Spec: Intel 
Core i7-7820X @ 3.60GHz [8-core Skylake X]) 
 
Results: 
4 concurrent 1080p 30fps HEVC or H.264 projects 
 
 

16270, 
16269 

Target CPU only HEVC Support 
 
HEVC (x265) codec support has been added to the following 
targets: 
- CMAF 
- DASH 
- RTP/UDP 
- SRT 
- Zixi 
- File 
 
Requirements: License purchase option needed.  Also, HEVC 
encoding is highly resource intensive, for realtime encoding of a 
single stream you will need at least a (Intel Core i9-7940X CPU @ 
3.10GHz) CPU for HD.  HEVC also requires more RAM, 32GB RAM 
(or more) is recommended. 
 

16272 
 

Target 4K Support 
 
4K frame size (3840x2160) was added to all Cambria Live 
targets. It is recommended to use levels of 6.0 and above when 
streaming in 4K.   
 
Requirements: CPU only 4K encoding is resource intensive, for 
realtime encoding of a single stream you will need at a minimum 
a (Intel Core i7-7820X @ 3.60GHz) CPU or faster.  4K also 
requires more RAM, 32GB RAM (or more) is recommended.  

16496 



Target Use GOP boundary/PTS Sync Mode 
 
A new option has been added "Use GOP boundary/PTS Sync 
Mode" under Option at the top of Live.  This option allows users 
to GOP/PTS sync multiple targets streaming from 
a Live instance. This can be useful when streaming out to Live 
Packager when you have multiple layers that need to be in sync. 
 
Notes: 
- All targets must have "Use fixed length GOP" enabled 
- All targets must have the same Maximum GOP / Minimum GOP. 
The Maximum GOP and Minimum GOP need to be the same value 
- All targets must have the same frame rate 
- Targets known to work thus far: SRT, RTP, Zixi   
 

16198 

BCM (Live 
Reboot) 

A new enhancement was added to the machine reboot feature 
(for Cambria Live machines) in BCM. A new dropdown option 
allows users to specify a time interval to spread out when 
machines are rebooted. For example, if the user has two Live 
machines and the interval is set to 30 minutes, one machine will 
reboot first and the other machine will reboot 30 minutes after. 
 

16449 



 

New Features/Changes for Live and BCM (For 4.7)  
 
Module Feature Capella 

Reference # 
Live (Target: 
CMAF, MPEG-
DASH, HLS)  

File output support from ABR target 
 
CMAF (Upload), MPEG-DASH (Upload), and HLS (Upload) targets 
have a new option under "Upload Target" called "File" which is 
dedicated to writing the output of the target to a file in the local / 
network filesystem. 
 

15687 

Live (AAC 
Audio) 

Higher target audio bitrates supported for AAC 
 
Live now supports audio bitrates of 256 kbps or more for AAC. 
This applies to all targets that support AAC audio. 
 
Notes:    
- Other non-AAC audio formats have a cap of 192 kbps 
- Audio bitrates at or above 448 kbps are not supported with the 
32 kHz sampling rate 
- MP2/MP3 and Mono do not support bitrates higher than 192 
kbps 
 

15977 

Live (Target 
Closed 
Captions)  
 

Convert ARIB B-37 to B-24 conversion (TS output) 
 
Cambria Live supports capturing ARIB B-37 data from SDI VANC 
input and converting it to B24 and embedding it into Transport 
Stream (i.e. RTP, TS, Zixi, SRT). 
 
New feature checkbox “ARIB STD B-24 (Subtitle) Settings” is 
located inside the main Options tab in Live. 
 

15647 

Live (Target 
Closed 
Captions) 

Convert ARIB B-37 to WebVTT conversion (HLS or Dash 
output) 
 
Cambria Live supports capturing ARIB B-37 data from SDI VANC 
input and converting it to WebVTT (embedded). 
 
Subtitle settings section added to HLS and Dash targets. 
 

15612 

Live (Skaarhoj 
Controller)  

Skaarhoj ‘Live Fly’ Controller Support 
 
Skaarhoj controller support has now been added to Cambria Live. 
 
In Cambria Live Option tab, you can enable/disable Skaarhoj 
Controller Settings which allow you to connect to a Skaarhoj 
controller and assign specific buttons from the controller to do 
specific Cambria Live functions. 
 
WebUI now includes a Cambria Live monitoring windows so that 
you can see changes made by the Skaarhoj controller. 
 

15611, 
15740 

LiveEdit / Live 
Editor 

LiveEdit / Live Editor segment stitching mode 
 
A new mode allows multiple segments to be submitted at the 
same time to be stitched into one file.  Allows for quick removal 

15648 



of commercial content and produce the commercial free output 
file soon after the end of the program. 
 
To enable the mode go to the ‘Options’ (dropdown)  ‘Live Edit 
Options’, check the "Use Segment Queue to submit multiple 
segments as single segment" checkbox. 
 
In this mode, you can use the timeline and ‘Set In’ / ‘Set Out’ 
buttons at the bottom of the application to set your in-out points 
for your segment.  Use ‘Add to Queue’ to add the segment to the 
‘Segment Queue’ list.  Finally, use the ‘Submit’ (button) in the 
‘Segment Queue’ section to submit the segments to FTC to create 
a single output file. 
 
Note: If you queue the segments to the Cambria Live Source List 
or Playlist, the output segments will be loaded in as separate 
segments, but arranged so that they can be played back-to-back 
easily.     
 

Client 
Application 
(Live Editor) 

Use hi-resolution source files in Live Editor as a primary 
input for editing  
 
Video files can now be imported directly into Live Editor to edit 
with (without needing a live editor project).  
 
There is an option in the File menu to "Open Video File". 
Only one file is supported per project.  Here are the allowed 
formats: 
- MPEG-4/.mp4/H.264/AAC 
- MPEG-4/.mov/ProRes/PCM 
- MPEG2-TS/.ts, .m2ts/H.264/AAC 
- MXF/.MXF/MPEG Video(XDCAM HD422)/PCM 
 
Limitation: Shared markers and waveform are not 
usable/viewable when this feature is used. 
 
 

15649 

Live and BCM 
and Client 
Application 
(Live Editor) 

Added language settings to Live, BCM and Live Editor 
 
Settings can be found under the 'Window' dropdown --> 
'Language Settings'. 
 
Options are: Auto / English / Japanese 
 

15832, 
15833, 
15900 

BCM BCM Redundancy improved to support multiple active NICs 
  

15802 



 

New Features/Changes for Live and BCM (For 4.6)  
 
Module Feature Capella 

Reference # 
Live (Target 
HLS/ DASH / 
CMAF) 

Performance optimization for ABR targets that share the 
same encoding settings 
 
Adaptive Streaming targets in Live now share encoder(s) if the 
targets have the same encoding settings (# of layers and layer 
configurations, frame rate, GOP size, etc). 
Encoders are shared in the following cases: 

1. Between 2+ DASH (Upload) targets 
2. Between 2+ HLS (Upload) targets 
3. Between 2+ CMAF (Upload) targets 
4. Between 2+ CMAF CTE targets 
5. Between 1+ DASH and 1+ CMAF/CMAF CTE targets 
 
Notes: 
- If using HLS (Upload) with the "Interleave Video/Audio Stream" option enabled, 
all HLS (Upload) targets with the same encoding settings must also have that 
option enabled, if you want the encoder to be shared. 
- Encoder sharing only occurs within the same Live instance. There is currently no 
sharing between Live instances. 

14244 

Live (Target 
RTP) 

Added Flexible Forward Error Correction (FEC) option to 
RTP 
 
There is new configuration in the RTP/UDP target where you can 
specify if you want to stream RTP with FEC to help recover from 
the inconsistent nature of UDP. 
You can choose the FEC option in the RTP/UDP target by checking 
the Use FEC checkbox and configuring a few attributes: 

1. Whether you want to use 1D or 2D as the FEC type 
2. If using 1D, you can configure the column number from 4 to 
20 
3. If using 2D, you can configure the column and row numbers 
from 4 to 20 (Note: column x row must be less than or equal to 
100) 
4. Normally, 1D uses one extra port (default is original port + 2) 
and 2D uses two extra ports (default is original port + 2 and 
original port + 4) 
5. You can change the extra ports that FEC uses by checking the 
"Specify FEC port(s)" checkbox and configuring your desired 
ports 

 
 

15520 

Live (Target 
Closed 
Captions)  
 

Support embedding ARIB B-37 Closed Caption (ARIB CC) 
to TS stream 
 
Cambria Live supports capturing ARIB B-37 data from SDI VANC 
input and embed it into Transport Stream (i.e. RTP, TS, Zixi, 
SRT) based on SMPTE2038 spec. 
New feature checkbox “ARIB STD B-37 (Subtitle) Settings” is 

14854 



located inside the main Options tab in Live. 
 

Live (Ad 
Insertion) 

Cambria Live can now do Ad Insertion without being 
connected to BCM 
 
In past Cambria Live versions, having BCM was a requirement to 
support Ad insertion workflows.  That limitation has been 
removed, Cambria Live can now do Ad insertion without needing 
to be connected to BCM.  However, the Ad insertion feature is a 
purchase option and will need to be added to your Cambria Live 
license in order for the Ad insertion functions to work.   
 

15390 

Live (Program 
Loop) 

Program Loop now supports pause and resume workflow 
 
This feature can be enabled with a new checkbox setting in the 
Program Loop UI called “Allow to start streaming from the middle 
of one loop”.  If this checkbox is enabled the Program Loop 
plugin can be deselected (either manually or through API) while it 
is running.  The operator would then presumably switch to 
another source input temporarily.  And when the Program Loop 
is selected again, the restart point of the loop will be based on 
current wall clock time, referencing some point in the middle of 
Program Loop. 
 

15424 

Live (Program 
Loop) 

Script to create ProgramLoopXML 
 
Capella can provide a Perl script that can be used to 
automatically generate the ProgramLoop.xml for a very specific 
workflow. 
 
This script will generate the ProgramLoop.xml list based on video 
files that exist in a specified folder. 
 
The script also can be used to add a Logo file layer. 
 
Note: this script will be called from CommandLine PlugIn 
periodically. Doing so, the user does not need to create 
ProgramLoop.xml from their end system.   
If you are interested in using this script please contact 
support@capellasystems.net for the script and instructions.  
 

15425 

Live (Minor 
Enhancements
) 

- Enhancement added for adding granular settings to transition. 
 
- When audio channel mapping is enabled in capture sources 
such as SDI, an icon now appears on the capture source 
thumbnail.  Icon image is a speaker with "L" and "R" below the 
speaker. 
 

15559, 
15556 

Live/BCM 
(Email 
Notifications, 
Monitoring) 

Gmail OAuth2 for Email Notifications 
 
There is now an option in Live (and BCM Monitoring) Email 
Notifications to specify a Gmail specific sender using the OAuth 
authentication process. This is similar to the YouTube and 
Facebook account add option where you log in to 
your google account via a web browser to allow Cambria Live to 
gain access to certain features. 
 
 

15432, 
15431 
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Live/BCM (API 
Test Tools) 

Both the BCM API test tool and the Live API test tool has been 
updated to include (port) options to select between BCM/Live and 
LPM/LP ports.  Please note that Live Packager Manager (LPM) 
and Live Packager (LP) are separate products and require 
different licenses then BCM or Cambria Live. 
  

15423, 
15420 



 

New Features/Changes for Live and BCM (For 4.5) 
 
Module Feature Capella 

Reference # 
Live (Capture 
Source) 

SRT Input Support (Cambria Live Pro only) 
 

14733 

Live (Capture 
Source) 
 

NDI Support (Cambria Live Pro only) 
 
NDI has been added as a capture source option.  Active NDI 
devices will show up as a selectable option in the NDI selection in 
Capture Source. 
 

14929 

Live (Source) Use Delayed Capture Mode 
 
Users can add a delay amount to the capture input, up to 30 
seconds.  The setting can be found in "Delay Amount in Delayed 
Capture Mode" when the "Delayed Capture Mode" checkbox is 
checked. 
 

11956 

Live (Targets: 
CMAF/HLS/ 
MPEG-DASH) 

Encoding optimization for CMAF/HLS/ MPEG-DASH targets 
 
Optimization to share encoding across multiple Cambria Live 
targets that use the Layers with the same exact attributes. 
 
“Interleave Video/Audio stream” checkbox must be checked in 
order for sharing to occur.   
 

14898 

Live (Target: 
Zixi) 

Zixi sender support (Cambria Live Pro only) 
 
Zixi/TS has been added as a Target in Cambria Live. 
 

14884 

Live (Targets) Latency Mode setting added to most targets 
 
For certain targets in Live, there is a new option "Latency Mode" 
under "Device Compatibility" in the "Encoding Settings" section 
which allows you to specify whether you want standard or low 
latency for your target. For best results, this should be combined 
with "Low Latency Mode" in the global options. 
 
The targets that now have this available are: 
1. RTMP 
2. YouTube 
3. Brightcove 
4. Facebook 
5. Microsoft Azure 
6. ULIZA 
7. Wowza 
8. SRT / TS (Cambria Live Pro only) 
9. RTP 
10. Zixi (Cambria Live Pro only) 
 

14977 

Live 
(Application) 

Support for custom keyboard shortcuts for ad insertion 
 
Short cut key settings are located under the Option menu. 
 

14818 



Live 
(Application) 

CORS support added for Live RESTAPI server 
 
RESTAPI server supports CORS now.  RESTAPI calls can be made 
from a web browser or web UI based tool to Live. 
 

14971 

BCM BCM supports configuring specific IP/Port to Cambria Live 
machines 
 
Allows for Cambria Live machines outside of the network to work 
with BCM. 
 
This setting can be found in the main BCM UI under the ‘Option’ 
dropdown as “Override External IP Address/Port”.  Set this to the 
Public IP (and Port) of your network that has BCM.  You will need 
to make sure that Port forwarding is used to direct 
communication (TCP/IP) to the BCM machine (forward the port to 
port 8753, used by the BCM machine). 
 
Limitations:  With this set to a public IP, Cambria Live machines 
in the BCM network will no longer be connected to BCM.  BCM 
backup however can be used in the same BCM network or the 
external network. 
 
 

14982, 
14857 

BCM WebUI added for BCM (Beta) 
 
On a BCM machine you can find instructions on how to set user 
permissions and start the WebUI here: 
C:\Program Files 
(x86)\Capella\CambriaBroadcastManager\cpx64\BCMWebUIUsers
_Readme.txt 
 
Note: not all BCM Manager features are available in the WebUI. 
 

14880 

BCM/Live 
(Licensing) 

Grace period mechanism improved so that a reboot will not 
automatically shut off the grace period. 
 

15045 

Live 
(Companion 
Application) 

Cambria System Monitor 
 
This application tool is automatically installed with Cambria Live.  
Currently, its main function is to cleanup old logs automatically. 
 
You can access the tool and settings by going to Windows 
Programs  Cambria System Monitor. 
 

14734, 
15070 



 
 

New Features/Changes for Live and BCM (For 4.4) 
 
Module Feature Capella 

Reference # 
Live (Capture 
Source) 

Genlock support 
 
Genlock works in Live through supported AJA cards. 
 

14246 

Live (CMAF, 
DASH, HLS) 

Direct upload to S3 
 
AWS S3 upload target has been added to the CMAF, DASH , and 
HLS Target Settings. 
 

14315 

Live (HLS) AWS MediaTailor support 
 
We now support AWS MediaTailor for manifest manipulation and 
ad insertion. 
 

13471 

Live (HLS) Manifest upload options added to HLS target 
 
1) Use absolute URL for media segments 
(When this is enabled, absolute URL prefix can be specified and 
child playlists will include this prefix for all segments) 
 
2) POST copy of playlists 
(When this is enabled, another URL can be specified where the 
copy of master/child playlist to be posted) 
 

14349 

Live Program Start/End marker 
 
Program start/end markers can be added to an HLS and Dash 
stream targets to signal a segment in the stream.  This is for 
compatible downstream replay/playout systems to replay that 
segment. 
 
Program markers are added via REST API.     
Please contact support@capellasystems.net for setup 
instructions. 
 

14382, 
14464 

Live Added MP3 audio codec 
 

14207 

Live Audio only RTMP supported 
 

14211 

BCM Added dBMeter on Multi Preview tab 
 
The audio meter refresh rate can be controlled through the 
‘Options” drop down menu.  
 

14526 

Live  Perl script plugin added to Controller Plugin  Command 
Line Plug-In Options 
 
The option to pass a Perl script to the program has been added to 
allow for more plug-in flexibility. 
 

14217 
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Note: We do not have any general script examples for this 
feature.  Please contact support@capellasystems.net for more 
information or to discuss possible usage. 
 

Live (Logging) Logging Enhancements 
 
1) Logs can be saved in UTF8 format. 
 
2) Logs now include Ad Start and End Markers.  
 
3) Settings for Snapshot Interval in the logging options have 
been added to increase user control.  
 

14386, 
14548 

Live 
(Prometheus) 

Additional values added to metrics used by Prometheus 
 
Thread count, number of handles, memory usage added to 
/Metrics. 
 

14703 

BCM/Live BCM programs can launch Cambria Live with GUI 
minimized with “Engine” mode 
 
Engine mode will disable certain GUI functions and also launch 
Cambria Live with the application minimized.  This allows for 
reduced resource use by UI functions so that more power can be 
allocated to the encoders. 
 

14536 

BCM/Live 
(YouTube 
authentication) 

YouTube authentication updates 
 
1) YouTube authentication method is changed to use System 
Browser instead of embedded browser to adapt current YouTube 
recommendations. 
 
2) Adjusted to a specification changes in YouTube's LiveStream 
API to fix YouTube event import error. 
 

14672, 
14654 

BCM/Live 
(Components) 

Capella Network Time Updater 
 
Capella Network Time Updater that is now a part of regular 
installation with Cambria products.  This Windows Service will 
make sure the machine’s clock is synced with NTP time. 
 

14243 

mailto:support@capellasystems.net


Features listed include all of the features added for Cambria Live/BCM 4.2, 4.2.1, 4.2.2, 4.3. 
 
***If you are currently using Cambria Live Ad Insertion with Cambria Live earlier than v4.2, 
we recommend that you understand what changes were made before upgrading to the new 
version of Cambria Live and BCM.    
  

New Features/Changes for Live and BCM (For 4.2 to 4.3) 
 
Module Feature Capella 

Reference # 
Live  CMAF chunked transfer support 

 
Chunked transfer encoding reduces playback latency of the live 
stream.  To enable chunked transfer, check the ‘Use Low Latency 
Mode’ setting found in video settings of a CMAF target. 
 
In addition to this setting there are two other settings that can be 
set to improve the speed of delivery.  ‘Use Accurate Reference 
Clock’ can be enabled from the options menu to improve 
streaming speed accuracy.  Also, ‘Use Low Latency Mode’ option 
will help reduce internal buffers, allowing for less latency between 
the Live input and Live output.      
 

13445 

Live AWS MediaStore and MediaTailor support 
 
CMAF, MPEG-DASH, HLS targets all now support streaming to 
MediaStore 
 

13819, 
13628 

Live  Brightcove SRT output support 
 
SRT/TS target exporter added to support SRT streaming delivery 
to Brightcove.  SSAI signals also work with SRT delivery. 
 

13785 

Live ULIZA RTMP output support 
 

14062 

Live ID3 support for Brightcove target 
 

13359 

Live AJA Kona 1 support added 
 
The AJA Corvid is no longer available as an option.  To support 1 
SDI input/output workflows, Cambria Live now supports AJA’s 
Kona 1. 
  

13465 
 

Live  
 

Increased the number of input audio channels that can be 
capture via SDI to 16 channels.  
 

13521 

Live  ARIB STD-B39 signal input support 
 
ARIB STD-B39 signals can be accepted by Cambria Live and used 
as triggers for switching to Sponsor break feed and Ad break.  
 

13234 

Live  Source file player added (including seek bar) 
 
The file player can be accessed through the properties tab in the 
clip settings.  The player does not affect the playback position of 
the file in the main Preview or Program windows.   

13619 



Live/BCM Ad Insertion Controls removed from Cambria Live and 
added to BCM 
 
Ad insertion controls/options including for Ad Insertion, SCTE,  
External Signal, Software Cue, Timecode Cue settings have been 
removed from the Cambria Live UI.  These controls/options have 
been moved to BCM.  This was done so that controls/options are 
centralized at a single controlling application which is aligned with 
streaming and ad insertion workflow expectations. 
 
A majority of the settings can now be configured from the BCM 
Program Dialog.  Below is the workflow descriptions for the two 
main ways to setup a program that includes ad insertion. 
 
Workflow 1: 

- User starts with Live, create project, test streaming, test 
ad insertion, save project 

- User goes to BCM, create Program and load project 
- Upon project changes, user will save to project file, and 

goes to BCM to reload the project 
 
Workflow 2: 

- BCM operator goes to BCM, creating "placeholder" BCM 
Program(s) 

- Live operator goes to Live, and create project, test 
streaming, test ad insertion and EXPORT it to BCM 
Program 

- Upon project changes are needed, Live operator will 
IMPORT project from BCM, modify and EXPORT back to 
BCM program 
 

Note: New for Cambria Live 4.6 / 4.6.1 and higher.  
Cambria Live can now do Ad insertion without needing to be 
connected to BCM.  However, the Ad insertion feature is a 
purchase option and will need to be added to your Cambria Live 
license in order for the Ad insertion functions to work. 
 

13177, 
13233, 
13273,  
13555, 
15390  

Live/BCM Manual setting added to Cambria Live to specify location of 
the BCM to connect to 
 
By default Cambria Live is configured to automatically detect and 
connect to a BCM machine on the same network.  You can 
disable this auto detection and manually specify the BCM that you 
want to connect to.  The settings can be found in Cambria Live 
under the BCM dropdown.  Select BCM Settings and uncheck 
‘Detect BCM Automatically’ to setup the manual BCM connect.      
 

13555 

Live/BCM If BCM is unreachable by Cambria Live then Ad insertion by 
Cambria Live will not work.  It is recommended that a BCM 
redundancy is setup to guard against this. 
 

14030 

Live/BCM When using the Ad Insertion feature, make sure that the 
transition in Cambria Live is set to "Cut" and not "Crossfade." 
If using the "Crossfade" transition, you may notice that the ads 
end with at least 1 frame of the ad slate as a result 
of the fading transition from the ad back to the main source. 
 
 

15578 



ABC Ad Break Control (ABC) tool is included with BCM to support 
manual Ad Insertion (including YoSpace manual 
insertion/prefetch workflows).  YoSpace Sparse Ad Break 
support.  ABC Configuration can be exported/imported. 
 
 

13278, 
13389, 
13267, 
13177, 
13790 

ABC Reuse Ad Break mode 
 
An option has been added to Ad Break Control to allow ads in the 
ad list to be reused.  In this mode, there is no “top down” ad 
order and an insertion can be requested by double clicking any 
Ad Break.  This Ad Break will be “reusable” fir the next ad break 
insertion request.  
 
To enable the Reuse Ad Break mode, go to the Ad Break Control 
settings  ‘Show Program Settings’.  Enable the ‘Reuse Ad 
Break’ checkbox.  
 

13452 

BCM / ABC Ad Break Control Interface has been added into BCM UI 
(tab) 
 

13449 

BCM “Placeholder” Program creation feature 
 
Allows users to schedule a program in BCM without specifying an 
existing project initially.  Instead, once the “placeholder” 
program has been scheduled, the Live operator may then create 
and test the project first, then EXPORT the project back to the 
“placeholder” program. 
 
Also if needed changes can be made to existing programs (with 
projects), operators can IMPORT the project from a BCM 
program, modify then EXPORT back to the BCM program. 
 
In order to create a “placeholder” program, select the ‘allow 
delayed project loading’ option from the program setting dialog 
box when a program is created or edited. 
 

13556 

BCM There are now different BCM licensing options based on which 
feature sets are needed.  Please contact 
sales@capellasystems.net for more information on the packages. 
 

13427, 
13269, 
13208 

BCM Live projects with Direct Show capture inputs are now supported 
by BCM  
 

13285 

BCM A Second Machine assignment has been added for Program 
Failover Stream handling 
 
Operators can now indicate a second Machine for failover 
handling of the specified Program. 
 
By default, BCM programs are set to (Auto) for Machine 
assignment.  Users may instead choose to specify a Primary and 
Failover machine for any Program by using the dropdowns in the 
Program Setting, Machine Assignment section.    
 
Users may indicate specific machines to use for Primary Stream, 
Failover Stream, and Failover Stream 2.  Machine assignment 
can also be set for YouTube backup streams, if the project 

13523, 
13594 
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contains backup streams. 
 

BCM / 
Dashboard 

Web-based Dashboard/Monitoring/Alerting 
 
Prometheus data output for Cambria is added. 
Please contact support@capellasystems.net for setup instructions 
of a dashboard for monitoring and alerting. 
 

13448 

LiveEdit/ Live 
Editor 

Create VOD clip from multiple LiveEdit segments 
 
A new mode has been added to allow for LiveEdit / Editor to 
submit multiple segments to FTC to be stitched into one file. 
 
This mode allows operators/editors to identify and mark program 
content that they want to keep in the VOD output and cut out   
commercial break content that is part of the original stream.   
 
LiveEdit / Editor can be configured for this mode by going to Live 
Edit Options under the Options (dropdown) in the main Live 
application.  Enable the ‘Use Segment Queue to submit multiple 
segments as single segment’ option. 

13588 

Licensing USB Dongle and Legacy Software Licenses are now 
centralized with Cambria License Manager   
 
This change allows Cambria License Manager to be the primary 
tool for seeing what license is used and if it is valid. 
 
Warning: If you are using a Software License (.lic), the location 
of where the licenses should be placed has is changed.  If a 
License File is being used, make sure the .lic file is added to this 
folder: 
C:\Program Files (x86)\Capella\LicenseManager 
 

13929 
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Known Issues 
Here is a list of currently known important issues.  Some of which will be fixed in future 
releases.  BCM specific issues are listed at the end of the Known Issues section. 

Cambria Live Known Issues 
Module Issue Capella 

Reference # 
Application Multiple Cambria Live instances (Purchase Option) 

 
Cambria Live supports having multiple open instances on the 
same machine.  With this feature enabled, you can have up to 4 
Cambria Live projects open and streaming on the same machine.   
 
Notes:  
- All instances will all share the same host machine resources. 
- Any single AJA input / output port cannot be shared among 
concurrent instances.  However, concurrent instances can use 
different ports from the same AJA card (Corvid-44).   
- Maximum concurrent instances are controlled by the dongle 
license.  1, 2 or 4 instance allowance can be programmed into 
the dongle license.  Please contact Capella sales for more 
details. 
 

9305 

Application 
(Video and 
Audio Sync) 
 

Removing audio playback device during Live operation 
may result in video/audio stuttering. 
 
Timing information is obtained from the audio device when they 
are in use.  If the audio device is removed, this may result in 
video/audio stutter.  
 

6342, 
6148 
 

Application 
(High resource 
use) 

Windows CPU affinity issue can result in drop frames. 
 
This issue has been observed to occur with the combination of 
these conditions: 
-Cambria Live setting “use physical CPU cores only” option is 
unchecked. 
-HP Z420 (Intel Xeon E5-1620 CPU). 
-Windows 7 (64-bit) 
 
Workaround: Disabling hyperthreading through the machine’s 
BIOS will keep this issue from occurring.  Another alternative 
workaround is to uncheck the “use physical CPU cores only” 
option in Cambria Live. 
 

7642 

Application 
(High resource 
use) 
 

CPU fluctuations with loaded project 
 
We observe that there are CPU fluctuations due to randomness 
of resources allocation by Windows 7. In the worst cases, some 
projects that use high resources may perform poorly when the 
fluctuations happen, such as significant and persistent drop 
frames in Cambria Live. To workaround this problem, simply 
restart Cambria Live and reload the project. 
 
To minimize these occurrences, we recommend the following: 
1) Check the option to “use physical CPU cores only”.  (Options 
dropdown) 

5626 



2) Use Quad Channel memory configuration for the Machine. 
 
Note: We have not observed this issue occur with Windows 10 or 
Windows 2016.  Windows 7 is not officially supported with the 
current build of Cambria Live.   
 

Source 
(File)  

Source file guidelines 
 
The system resources required to handle a given file may vary 
based on source format, source properties, and encoding 
attributes.  CPU usage in some cases can vary up to 30% due to 
the type of source used.  Listed below are guidelines that are 
relevant when using a machine similar to our Recommended 
System or Minimum System Specification.  Not following these 
guidelines will increase your chances for video/audio stuttering in 
your preview windows as well as your RTMP output video. 
 
 
Guidelines: 
●  Use WMV, MPEG, or H.264 files (These formats were the 
focus of our testing.  Other formats may be able to be used as 
sources, but the performance/usability of other formats have not 
been tested). 
●  To reduce some overhead you can use SD sources and 
sources 
with the same frame rate as the encoding target frame rate. 
●  Files that are not seekable cannot be used (Files may not be 
seekable for a various reasons, common cases include files with 
discontinuous or missing timestamps - if you encounter a file 
that is not seekable, please contact our support team and we can 
investigate the issue). 
● MP4 files that are Open GOP, can take a long time to seek to 
specific points in the file.  Switching can have a delay when 
switching to Open GOP MP4 files in Cambria Live.  It is 
recommended that Closed GOP MP4 files be used instead. 
● To avoid some network related issues, you should use sources 
that have been stored on the local machine.  If you are using 
network sources, please make sure that your read speed to the 
network source is fast enough to handle the file in real-time. 
● Do not use \\localhost to point to a file on the local machine to 
avoid Windows Media Foundation file reading issues.  It is 
recommended to use \\machineName instead.  
● MOV files with alpha channel is supported through the 
PiP/Audio column. 
● A small subset of MP4 files may fail with an audio decoder 
error.  If you run into this issue please contact 
support@capellasystems.net.  This issue has been resolved and 
we can send you a new build to use.   
 

3170,  
4110, 
5958, 
6344, 
7868, 
8207, 
14056 

Source 
(File) 

Increased source file cap to 1000 files; UI can become 
more sluggish 
 
The maximum number of source files that can be loaded into 
Cambria Live is 1000 files.  We are now loading files into 
multiple separate processes thus we are no longer have memory 
restrictions due to loading sources into a single process. 
 
Known issue: UI functions and features can become more 
sluggish and less responsive when sources are using up a large 

4804,  
5095, 
7325 
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amount of the system memory. 
 
Example: On a machine with 8 GB RAM, UI navigation became 
sluggish with this many 20 second SD files loaded: 
WMV – 150 files 
MPEG (TS) – 200 files 
H.264 (MP4) – 270 files   
 
Warning: Some files require more memory than others.  By 
using files that have high memory requirement, it is still possible 
that Cambria Live will run into a memory deficiency problem due 
to running out of overall system memory.  In these cases, it 
may be necessary to install more RAM onto the system. 
 

Source 
(Capture) 

It is recommended to have all capture sources have the 
same framerate 
 
With the AJA Corvid-44, the application cannot correctly detect 
framerate for subsequent inputs after the first. 
 

8768 

Source 
(Capture) 

1080p59.94 or 1080p60 capture through AJA Corvid/LHi 
can cause drop frames and is not official supported 
 
Due to the AJA Corvid/LHi buffer level, (1080p59.94 or 1080p60) 
input will likely cause dropped frames.  The dropped frames 
occur when switching to the capture source.  The amount of 
dropped frames can vary from a few frames to persistent drop 
frames.  This variance is due to machine configuration. 
 
Workaround: Using a recommended slot configuration for 
officially supported HP workstations can minimize the drop 
frames, but it will not completely eliminate dropped frames 
caused by this issue: 
 
Z820 – Slot 6 (recommended), Slot 4 (compatible, 2 CPU config) 
Z620 – Slot 5 (recommended), Slot 4 (compatible) 
Z420 – Slot 5 (recommended), Slot 4 (compatible) 
Z800 – Slot 5 (recommended), Slot 4 (compatible) 
 
Recommendation: This issue can be completely avoided by 
using the AJA Corvid-44 card.  Please contact Capella for 
purchase details.  
 

7457 

Source 
(Capture) 

Virtual Cam crop accuracy 
 
It is a technical requirement that the horizontal and vertical 
resolution of the cropped area for Virtual Cam must be a multiple 
of four.  The red crop box does not accurately represent this 
requirement.  Because of this, the actual virtual area used for 
streaming may include a small amount of video outside of the 
red crop box area. 
 

5386 

Source 
(RTP) 

Real-time Transport Protocol (RTP) source support 
 
RTP streams can be used as source capture inputs in Cambria 
Live.  These capture inputs can be used as the only video to be 
streamed or as part of a composite group. 
 

5966, 
9316 



Limitations: Not all RTP output devices are supported.  Due to 
the variances that exist in RTP steams for different output 
devices, there is a possibility that the output of your RTP device 
will not work natively with Cambria Live.  If RTP output from 
your device is not compatible with Cambria Live, please contact 
Capella support. 
 
Note: Expect a 4 sec delay, in ideal network conditions, when 
sending RTP from Cambria Live to a second Cambria Live (using 
this RTP as a source). 
  

Source  
(SXH-360  
DVI input) 
 

DVI input into Cambria Live 
 
Preview Quality: 
If you input a signal through DVI input which contains content 
with text, the text may not be clear when you are previewing it 
through the staging or streaming preview windows.  This is 
expected behavior.  The preview windows have a set size where 
in order to view the DVI content it must be scaled to fit the size 
of  
the preview windows.  This scaling can make text look distorted 
or unclear.  The output quality should look better than what is 
seen through the preview windows.   
 
Streaming and Filewrite output quality: 
To improve output quality, you can eliminate scaling steps by 
using one of these two methods: 
 
● Match the target to the source (example: source is 1080p, 
target is set to 1080p) 
 
● Match the source to the target (example: target is 1280x720, 
change source signal to be 1280x720 or use Virtual Cam and 
crop to that selection size) 
 
Configure Computer DVI output to improve performance: 
If you are inputting DVI from a Computer into Cambria Live, you 
should configure the DVI source frame rate to match the 
Cambria Live project frame rate for optimal performance.  For 
example, if your Cambria Live project is set to a global frame 
rate of 30fps, you should configure your DVI output from your 
computer to output DVI at 30 Hertz.  However, when changing 
the DVI input properties, please make sure that Cambria Live is 
not open. 
 
Warning:  
When changing resolution of other options for the DVI input 
signal, Cambria Live may crash.  Please make sure that Cambria 
Live is not open, when changing the display properties of the DVI 
input.  In addition, the display resolutions of 1366x768 and 
1280x800 are not officially supported.   
    

5421,  
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Source 
(Capture) 

DirectShow camera support 
 
DirectShow compatible USB cameras are now supported in Live.   
 
Tested cameras: 
Lenovo Built-in Webcam 
Logitech HD Pro C920 
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MagicCam (virtual Webcam) 
 
Note: DirectShow camera support does not apply to Broadcast 
Manager or clients. 
 

Source 
(Playlist) 

Limitations for Capture Source Inside Playlist 
 
1) Capture sources inside playlist will always use the original 
audio for the capture source. 
 
2) VC capture sources are currently not supported. 
 
3) Capture source inside playlist is not supported by the source 
failover function. 
 

3606, 
7093 

Source 
(Playlist) 

Slow source playback recovery 
 
After playlists playback sources that decode slower than 
realtime, the playlist will try to “catchup” by playing other files 
faster than realtime for a short period. 
 

6714 

Source 
(Power Point 
and PDF) 

Requirements for Power Point Importer for Live 
 
PowerPoint files (.pptx and .ppt) and PDF files can now be used a 
source assets.   
 
Requirements: 
● Install LibreOffice (Version 9.2.5.2). Download at: 
http://www.libreoffice.org/download/libreoffice-fresh/ 
● Install GhostScript (64 bit) (Version 9.14).  Download 
GhostScript 64 bit at: 
http://www.ghostscript.com/download/gsdnld.html 
 
Features: 
● Go to previous, next, and beginning of slides 
● Automatic playback for slides 
● Slide reordering 
● Jump to any slide 
 
Limitations/Known behaviors: 
● Long loading times can occur when adding PowerPoint or PDF 
files with lots of slides (eg it can take 30s to load a PPT source 
with 100 slides) 
● Files with lots of slides can consume a large amount of the 
applications memory (eg 100 slides uses around 1182 MB). 
 

7560, 
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Source 
(Switching) 

If a source is being previewed in the Staging Preview before 
being applied to the Program Output a duplicate frame or old 
frame may exisit in the output at the time of switching. 
 
Recommendation:  This issue does not occur if the source 
being applied is not previewed first.  Applying to both previews 
at the same time will eliminate the duplicate/old frame problem.  
Also, this issue is being investigated and will be fixed in a future 
release. 
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Source 
(External Signal 
/ SCTE 
switching) 

A PiP or Layer may not be applied if the user applies it manually 
at the same time that an External Signal (or SCTE) switch is 
occurring.  If this occurs, reselect the PiP/Layer and it will apply.  
 

9160 

Source 
(Failover) 

A Cambria Live project will not switch to the Failover Source if 
the Capture Source had no signal to begin with.  The failover will 
only trigger once the Cambria Source has signal and loses it. 
 

11269 

Source and 
Target 

SCTE 35/104 Support 
 
Source: 
● Read SCTE 104 from VANC area of SDI input 
● SCTE 35 in TS RTP 
 
Target: 
● We translate the source SCTE data and embed it in RTMP 
output  
 
Commercial Switching: 
● Using the SCTE data we can automatically switch from the 
capture source to a commercial playlist and back.   
 
Supported Input Signals: 
● 1080i (29.97, 25) 
● 720p (59.94, 50, 25) 
 
Limitations: 
● SCTE support is limited to 1080i and 720p, 1080p is not 
supported. 
● YouTube Live Programs using SCTE to trigger YouTube Ads 
must have the YouTube Live event setting “Sync to preview 
player” turned OFF when streaming is started.  It is 
recommended to use the “Start Broadcasting for YouTube 
Targets” from Cambria Live’s options drop-down menu.  This 
function will automatically turn OFF the “Sync to preview player” 
setting when starting YouTube streaming.        
● SD inputs are not supported when capturing VANC using the 
AJA Corvid-44 with multiple inputs.  All input signals must be 
HD, otherwise SCTE capture and/or any capture input could be 
distorted.   
● SDI output is not supported when capturing VANC with AJA 
Corvid or LHi cards.   
 

8134, 
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PiP 
(Video Files 
with Alpha) 
 

Warning! High resource use for PiPs using Video or Image 
Files with Alpha 
When using the combination of PiPs containing alpha layers with 
the PiP Video Control settings, the project will consume a large 
amount of the system’s resources.  This may lead to dropped 
frames. 
 
Recommendation: When this issue occurs, uncheck the PiP 
layer.  Do not use Video Control on Video Files with Alpha. 
 

8525, 
8524 

Target Starting and stopping MBR streams  
 
If you are streaming multiple streams to the same channel.  
Stopping or starting one of the streams will cause all the actively 
streaming streams in the MBR group to restart. 
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Target ‘Control Room’ function and ‘Go to Preview Page’ function 
for You Tube targets 
 
In order see video previews when using these functions for 
YouTube targets, it is recommended to have a HTML5 supported 
browser.  
 
 

4006, 
8821 

Target  
(Output) 

RTP output, low latency mode 
 
RTP streams can be generated by Cambria Live as an output.  
When RTP output delivery is used in conjunction with the “low 
latency mode” preset setting, the stream can be delivered to 
playback devices in less than 1 second. 
 
Limitation: Delivery to multicast addresses is not currently 
supported.  Also, do not use the ME Mode = 2 (High Quality) 
target setting in conjunction with the “low latency mode”, this 
will result in dropped frames. 
 

4925,  
4924 

Target 
(Filewrite 
Options) 

Split Target File at Every Specific Period 
 
In the Options Settings for file targets, output files can be setup 
to automatically split based on a user specified time period.  
This feature allows the user to create separate archive files of 
their live programs as the program is streaming.   
 
Limitation:  In order to make sure all content is captured, there 
will be a minor overlap of video content between the end of one 
file to the start of the next file.  This overlap will be less than or 
equal to 1 GOP size in length.  
 

8495 

Target  
(SDI Output) 
 

Noise in SDI target output when VANC setting is ON but 
no SDI input is used 
 
There can be a few lines of noise that appears at the bottom of 
the video.  The noise is seen in the Cambria Live preview as well 
as the SDI input.   
 
Workaround:  Disable the VANC setting.  The setting can be 
found on the ‘Option’ menu dropdown. 
 

10904 

Target 
(SDI Output) 

SDI output limitation, use matching formats for input and 
output 
 
SDI output must match the same frame size, framerate, and 
interlacing of the incoming SDI or HDMI input.  This is a 
limitation that exists for the AJA Corvid, LHi, and Corvid-24.  If 
input and output format does not match, this could cause SDI 
output not to work.  
 

8047, 6843 
 

Target 
(YouTube) 

YouTube account refresh tokens can be expired under 
certain conditions. 
 
Here are some reasons this may have happened: 
● The token has been unused for 8 months 
● The user has authorized more than 25 tokens per domain (for 
which there is a FIFO queue) 
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● The user has authorized more than 600 tokens in total (for 
which there is a FIFO queue) 
 
When an expired refresh token is encountered, the currently 
logged in YouTube account will not work and will need to be 
removed through the Cambria Live Account Manager.  Once 
removed add the account back into Cambria Live. 
 

Target 
(YouTube) 

Support for YouTube’s Single-use Stream Key / Variable 
preset 
 
YouTube allows for Variable preset, which is automatically used 
when the ‘Single-use stream key’ is selected from YouTube 
settings.  Variable preset is also an option when using a 
Reusable stream key. 
 
With the Single-use stream key / Variable preset, the YouTube 
Program is no longer fixed to a specific video format (ex: 480p).  
Cambria Live can be used to stream any YouTube target preset. 
 
By default Cambria Live will be configured to output 1080p when 
a Variable preset is being used for the YouTube Program.  You 
can change the video format from Cambria Live at anytime. 
 
Warning:  Cambria Live versions older than 3.5 will not work 
with YouTube when the Single-use stream key or Variable preset 
is selected. 
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Target 
(YouTube) 

Manual configuration warning for YouTube target preset 
settings 
 
Distorted playback of the program from YouTube can result if the 
YouTube target in Cambria Live is manually configured to a 
different frame rate/resolution than what is specified for the 
program on YouTube.   
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Target 
(YouTube) 

Start and stop broadcasting for YouTube targets 
 
There is a delay/offset between when the start/stop broadcasting 
command is issued and when this actually takes effect on 
YouTube Live.  This can lead to missing around 30sec to 1min of 
program content at the beginning of the live stream.  And stop 
broadcasting can result in around 5 to 10 seconds of missing 
content at the end of the program. 
 
Recommendation:  Use a preroll or slate file prior to seeing 
the "Broadcasting" status for the target in the targets tab.  
Switch to the main program content when  “Broadcasting” is the 
status shown.  If you are using the scheduler, then setup a 
preroll to run automatically for 30+ seconds prior to the start of 
your show.  For stop broadcasting, stop the broadcast 10 
seconds after your intended stop point.       
  

7459 

Target 
(YouTube Ad 
Insertion) 

Cambria Live Ad Insertion not compatible with YouTube 
Control Room Preview feature 
 
YouTube Control Room preview function “Sync to preview” can 
cause Ad Insertion from Cambria Live not to work.  When 
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running into this issue you will see an error message from 
Cambria Live after using Ad Insertion informing you of this case.  
 
Recommendation:  To avoid running into this issue, do not use 
YouTube Control Room to preview the stream prior to using the 
“Start Broadcasting for All YouTube Targets” from Cambria Live.  
Doing so will automatically deselect the “Sync to preview” setting 
before YouTube streaming / broadcasting.   
  

Target 
(Facebook) 

Facebook Live support 
 
Facebook Live has been added as a target option. 
 
Notes: 
- Facebook account authentication done through account 
manager. 
 
- Once you start streaming is when the post will show up on 
Facebook along with the streaming video. 
 
- When the “Stop Streaming” button in Cambria Live is used, 
Facebook will end your live video broadcast automatically after a 
short time if you are not streaming to it.  This will give you a 
chance to restream back to the same program if you did not 
actually intend to stop streaming.  But once Facebook has ended 
the broadcast (usually within 1 to 3mins), you will no longer be 
able to stream video to the same Facebook post. 
 
- If “Stop Broadcasting” option on our target menu dropdown at 
the top of the application.  This will immediately end your 
broadcast, and you will not have a chance to restream to it.  
But, your VOD for the post will start generating right away. 
  
 
Known Issues:   
1. Your Facebook privacy options for the Cambria Live app may 
be set to ‘Friends’.  If this is set on Facebook, then any 
Facebook post will be set to ‘Friends’ automatically, even if the 
Cambria Live target setting contains Privacy=Public.  To fix this 
issue you can go to Account Settings >> Apps, and find the 
Cambria Live app, there is a setting where you can edit 'App 
visibility and post audience'. Set this to ‘Public’.  Another 
workaround is to switch the Privacy setting directly from the 
Facebook post.   
   
2. Distorted playback of the stream on Facebook can result if the 
Facebook target in Cambria Live is manually configured to a 
different frame rate/resolution after it has started streaming. 
 
3. If system time is used as RTMP timestamp, stream cannot be 
streamed to Facebook Live.  Please disable checkbox “Use 
System Time as RTMP Timestamp” from “Show Advanced 
Setting” in target setting. 
 

10783 
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Target Wowza Server Configuration 
 
If your Wowza server is configured to ‘Require password 
authentication’ for RTMP sources.  Then make sure to configure 
these two items: 
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1) A user and password needs to be added in the ‘Source 
Authentication’ page in Wowza.   
 
2) In the ‘Source Security’ section, add “CambriaLiveX” to the 
Flash Version String.   
 
Note: If RTMP Sources is configured to ‘Open (no authentication 
required)’ then neither of the above steps are necessary to allow 
for Cambria Live to stream to Wowza. 
 

Target 
(Akamai) 

Akamai Certified RTMP streams 
 
Cambria Live RTMP streams sent to Akamai servers have been 
certified to be compliant with Akamai specifications.  
 
If you are streaming multiple resolutions/bitrates to the same 
Akamai server, you should make sure the ‘Sync GOP across 
Multiple Streams’ option is checked ON.  Here is where you can 
find checkbox option in the Target Settings:  
 
‘Target Setting’  ‘Show Advanced Setting’  ‘Sync GOP across Multiple Streams’ 
 

9225 

Target  
(CMAF) 

CMAF CTE uses up more memory over time than expected. We 
recommend not to do CMAF CTE streams more than 24hours. 
 

14687 

Target 
(Ooyala) 

Streaming RTMP to Ooyala  
 
Cambria Live can streams RTMP to Ooyala. 
 
Known issues: 
1. If the number of audio channels is changed while the encoder 
is encoding, there may not be audio on the player side.  The 
workaround is to stop the encoder first for 30 seconds before 
applying the change. 
 
2. If and audio only stream is sent to Ooyala, this may cause 
their encoder to fail and there will be no video on the player until 
the server restarts.  Do not send audio only RTMP. 
 
 

11404 

Live 
(Target) 

Periscope support 
 
The RTMP Server target supports streaming to Periscope.  
 
Note: Modify the target settings to match recommended 
periscope settings.  The ‘Maximum GOP’ in the presets 
‘Advanced Settings’ should be changed to 60 to match 
Periscope’s recommended key frame interval.    
 

11727 

Target and 
Global Project 
Settings 

Default Target Aspect Ratio settings has been changed 
 
The default Target aspect ratio settings has been changed from 
“Same as Capture source” to “Same as Project Aspect Ratio”.  
This change has been made so that the aspect ratio of the output 
can be consistent and more easily maintained.   
 

6620 

Target and 60fps targets are supported  6690 



Global Project 
Settings 

 
60fps target outputs can be configured through the target preset 
configuration.  However, 60fps project settings are not currently 
officially supported.  Some modules related to 60fps handling 
will need to optimized to resolve issues with 60fps in the 
application. 
 
Note: We will be supporting the full 60fps workflows in a future 
build. 

Remote 
Desktop (Audio 
Sources) 

Remote desktop support, connecting WaveIn audio 
devices 
 
The remote machines non-Aja audio sources will be hidden in 
Windows and also in Cambria Live (through Remote Desktop). 
 
Workaround: 
1. Open remote desktop connection options 
2. Local resources > Remote Audio > Settings 
3. Remote Audio Playback > Play on remote computer 
   

6133 

Remote 
Desktop 
(Preview) 

Remote desktop can cause Staging Preview and Program 
Output to stutter 
 
When using remote desktop to connect to a machine running 
Cambria Live, stuttering may occur in the Staging Preview and 
Program Output windows.  The actual output streams 
(RTMP/UDP/filewrite/SDI out) are not affected.  However, the 
stuttering in the preview and output windows cannot be fixed 
until the program is restarted.   

8615 

Remote 
Desktop 
(Preview) 

Remote desktop support, preview refresh rate 
configuration 
 
Performance of Cambria Live through windows remote desktop 
can be improved by configuring the “Preview Refresh Rate” 
feature.    
 
You can access this setting by right-clicking either preview 
window in Cambria Live:   
 
Preview refresh rate options are:  
 High - full frame rate (same as original source frame rate) 
   Medium - update every 125 ms (8 fps) 
   Low - update every 500 ms (2 fps) 
 
This user setting will be remembered by the application.  In 
addition to this refresh rate setting, we also recommend that the 
display settings for Windows Remote Desktop Connection are 
kept at the default quality settings. 
 
 

3323 

Audio Realtek High Definition Audio drivers 
 
HP Z800 system can crash when Realtek High Definition Audio 
drivers are used in conjunction with the Cambria Live beeping 
notification feature. 
 
Recommendation:  Remove the “Realtek High Definition 
Audio” drivers from the machine and install “High Definition 
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Audio” from Windows.  Or disable the beeping feature. 
 

Keyboard 
Controls 

Keyboard Shortcuts 
 
List of Keyboard Shortcuts: 
Global in the application: 
● Composition: Ctrl+1 ~ Ctrl-9 to apply composition (up to 9 compositions) 
● Switch to Log/Status tab: F1 
● Create Composition from current selection: F2 
● Apply to OnAir/Flip: F5 
● Transition ON/OFF: F7 
● Start Streaming: F8 
● Stop Streaming: Ctrl-F8 
● Program Output preview target selection: F9 (Previous target), F10 (Next 
target) 
● PowerPoint / PDF slide selection: F11 (Previous slide), F12 (Next slide) 
● Search Source: Ctrl-F 
● Open Project: Ctrl-O (Usual short cut in Windows) 
● Save Project: Ctrl-S (Usual short cut in Windows) 
 
Applicable only if the list is focused: 
● Switch between Sources/Pip/Layers: 1 ~ 9 (1 is the first source, 9 is the 
9th source) 
● Delete: Ctrl-Del 
● Edit: F4 
 

6065, 
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Live Tool 
(Reboot 
Manager) 

Machine Rebooting Manager Tool 
 
The Machine Rebooting Manager is a new tool that is installed 
with Cambria Live.  This tool allows users to configure automatic 
periodic maintenance reboots for the Cambria Live machine. 
 
Once you launch the tool from the Windows Start Programs 
group, a Cambria Live icon will appear in your Windows System 
Tray for the Reboot Manager.  You can double-click on this icon 
to access Reboot Manager settings.   
 
Note: Cambria Service will try to relaunch Cambria Live with the 
same state as before the reboot occurred.  Microsoft Window’s 
auto-login configuration is required so that Windows can log into 
the same user account after reboot.     
 

12047 

Live Plug-in 
(Program Loop 
XML) 

Plug-in: Program Loop XML 
 
This Plug-in allows for an XML file to be used to automatically 
generate a Cambria Live looping asset list. 
 
The XML contains information on what assets 
(Source/PiP/Layers) to use, asset and fade durations, ad 
insertion points. 
 
The installer can be found in the Cambria Live installation 
package in the LivePlugInProgramLoop folder.    
 
Once installed, you can access the options for the Plug-in 
through the Controller Plug-in Manager.  Cambria Live will watch 
the specified folder location for the XML and changes made to 
the XML.  This Plug-in provides an convenient mechanism for 
other systems to control a Cambria Live looping playlist through 
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just updating the XML.    
 

Live Plug-in  
(CommandLine) 

Plug-in: Command Line 
 
This Plug-in allows for running command line program (Ex: batch 
file, Python script) periodically. 
 
The installer can be found in the Cambria Live installation 
package in the LivePlugInCmdLine folder.    
 
Once installed, you can access the options for the Plug-in 
through the Controller Plug-in Manager.  4 plug-ins entries are 
provided so that a total of 4 separate programs can be run.  
When the program is restarted at the specified interval, the 
previous program for that specific plug-in entry will be 
terminated if it is not already finished. 
 

12456 

Client 
Application 
(Live Editor) 

Cambria Live Editor (Purchase  Option) 
Live Editor is a client application that runs on a separate machine 
and uses the proxy file output and shared markers from Cambria 
Live to allow a second operator to accurately set in/out points for 
“highlight segments” from the live stream.  These segments can 
be reused in the live broadcast or be submitted to File Convert 
for file transcoding to other formats.  Transcoding progress of 
submitted segments can also be tracked through the Live Editor. 
 
Minimum System Requirement: 
Operating System: Windows 7 (64-bit) and Windows 8.1 (64-bit) 
Processor: Intel Core i5 (4-core) 
Memory: 4GB RAM 
Video Card: Supports Direct3D acceleration 
Network Adapter: Gigabit Ethernet 
USB Port: (for Capella Live Editor license dongle) 
 
Limitations:  
● Live Edit / Editor supports up to 1000 Markers. 
● When two Live Editor client machines add shared markers 
within 10 seconds, the second machines marker will overwrite 
the first.  
● The network disconnect warning for Live Editor will not be 
shown if the Live file output location is on the Live Editor 
machine. 
 

8499, 
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Source 
(Desktop 
Stream, 
Companion 
Application) 
 

Desktop Stream (Remote) added to Installation Package 
 
Desktop Stream is a companion application that can be installed 
on a separate machine within the same network.  This 
application will allow the desktop of the machine to be streamed 
to Cambria Live.  Cambria Live will use the desktop as a Capture 
Source. 
 
Desktop Stream requires a serial number.  Please contact 
Capella for a serial number. 
 
Usage Recommendation: To reduce memory bandwidth and 
increase performance, it is recommended to use the “Turn Off 
Aero” button from the Desktop Stream configuration dialog.   
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Computer 
Hardware 
(Video Card) 

Remote Desktop and NVIDIA 
 
A case was discovered where when Remote Desktop was used to 
access the machine with Cambria Live, the application would 
freeze/get stuck.   
 
Recommendation: If you are running into this problem please 
update your NVIDIA card drivers to the latest version. 
http://www.nvidia.com 
 

11307 

Computer 
Hardware 
(Video Card) 

NVIDIA cards with ‘Fermi’ architecture 
 
Memory leak when resizing the main Cambria Live application 
window on computers with certain video cards.  This problem 
can lead to an application crash. 
 
NVIDIA cards with the ‘Fermi’ architecture are known to cause 
this problem.  
 
Recommendation: If you are running into this problem please 
update your NVIDIA card drivers to the latest version. 
http://www.nvidia.com 
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Computer 
Hardware 
(Video Card) 
 

AMD Gaming Evolved App by Raptr can cause Cambria Live 
to crash 
 
AMD Catalyst Software Suite contains an app called AMD Gaming 
Evolved.  It has found that if this application is installed on a 
Cambria Live machine, the Cambria Live UI can crash due to an 
unexpected behavior by the graphics driver. 
 
Recommendation: If you are using AMD graphics cards, do not 
install the AMD Gaming Evolved App. 
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Windows 
Component 

UsoWorker can cause run-out-of-memory error 
 
To avoid this error, turn off Windows Delivery Optimization. 
https://www.xplornet.com/support/internet/how-to-disable-
peer-to-peer-updates-in-windows-10/ 
 

16572 

Windows 
Component 

Maximizing / minimizing other Windows 
applications/browsers can cause dropped frames 
 
Recommendation: You can eliminate this issue by disabling the 
“Animate windows when minimizing and maximizing” setting or 
use the “Aero” theme. 
  

8142 

Windows 
Component 

Disable Microsoft Window’s Hibernate/Sleep mode 
 
Cambria Live does not support Microsoft Window’s 
Hibernate/Sleep mode.  If a computer goes into Hibernate/Sleep 
mode while Cambria Live is open, the computer may crash 
(BSOD) or the Live application may freeze.  The hardware 
drivers and other 3rd party modules do not support 
Hibernate/Sleep mode. 
 
Recommendation:  Disable Hibernate/Sleep on the Cambria 
Live machine: 

3764 
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1. Go to Control Panel>Power Options 
2. For the selected preferred plan, select ‘Change plan settings’ 
3. Select ‘Change advanced power settings’ 
4. Go to Sleep>Allow hybrid sleep 
5. Change the setting to “On” (this change will disable the 
Hibernate option in the start menu) 
6. Go to Sleep>Hibernate after 
7. Change the setting to “Never”  (this change will keep the 
system from Hibernation when it sleeps) 
 

 

 

Broadcast Manager (BCM) Known Issues 
Module Issue Capella 

Reference # 
Programs  / 
Frame Rate 
Family  

Project Frame Rate Family / SDI input and output/ Kumo 
routing 
 
Frame Rate Family (FPS Family) is a group of frame rates.  There 
are 3 frame rate family groups: 
1: (24/30/60) 
2: (25/50) 
3: (23.976/29.97/59.94) 
 
Multiple SDI input and output issues/behaviors: 

- The input signal frame rate for SDI port 1 will set the FPS 
Family of the other SDI ports on the Corvid-44 card (ports 
2-4). 

- If ports 2-4 are not the same FPS Family as port 1, then 
ports 2-4 will not be able to detect the SDI input signal 
correctly. 

- FPS Family for the card is remembered until it is changed 
by sending a different FPS Family signal to SDI port 1.  

 
Kumo issues/behaviors: 

- If the Live Project has a Kumo port selected and does not 
have a FPS family set, the project will not start.  The 
project will also not start if the FPS family used in the 
program setup does not match the FPS family settings 
used in the Kumo configuration.  

- BCM does not detect routing conflicts across programs.  
Currently, the latest launched program will override the 
previous Kumo routing. 

 
  

10820, 
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Programs Cambria Live 3.0 projects (or earlier) are not compatible 
with Broadcast Manager 
 
Old Cambria Live projects, created in Live 3.0 or earlier, do not 
have sufficient information to be fully compatible with Broadcast 
Manager.  Some files referenced in the old projects may fail to 
load when the program is launched by Broadcast Manager.   
 

9336 



Recommendation:  You can load the old project in Cambria Live 
3.1.0 and resave the project which fixes the issue with the file 
references in the project.  It is also recommended that you check 
all other aspects of the project before resaving. 
  

Programs If no established redundant connection is configured, 
programs will error out if BCM machine is disconnected 
from the network 

10869 

Programs 
(Machine 
Assignment) 

Fixed Machine Assignments for Programs / Backup 
Programs / Program Failover 
 
By default BCM will assign programs (primary, backup, failover) to 
Cambria Live machines automatically based on internal logic.  To 
the operator this assignment may appear un-deterministic.  
Machine assignment options have been added to the BCM’s 
Program Settings to allow for programs to be assigned to a user 
specified Cambria Live machine. 
 
Warning:  By assigning a program to a specific machine, the 
automatic failover for the program will be set to “(not used)”.  If 
program failover is desired for this program, then the user must 
also specify a specific machine for program failover.  Also, BCM 
will not indicate if there are sufficient machine resources to run all 
of the failover Programs concurrently.    
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Programs 
(Failover) 

Live source failover BCM program failover 
 
If BCM program failover restarts a program where a Capture 
Signal source has no signal (and Live source failover has 
triggered), the Live failover feature will no longer work when the 
capture signal has returned.   
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Programs 
(Failover) 

Preroll source may not be streamed once Broadcast 
Manager program failover retries the program 
 
When a program session fails and triggers the Broadcast Manager 
program failover, the program will be retried (usually on a 
different machine).  The new retried program session may stream 
black video for the rest of the preroll period.  After the preroll 
period, Cambria Live will switch normally to the main source 
defined by the program project. 
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Programs 
(Error 
Handling) 

Cambria Live target errors are not handled by Broadcast 
Manager program error handling 
 
Cambria Live target errors such as encoding and network delivery 
errors are not handled by Broadcast Manager program failover.  
(Example: If an RTMP destination suddenly becomes unavailable 
the Broadcast Manager will not try to terminate the instance and 
start it on another machine.)  Cambria Live target errors may 
instead be handled by Cambria Live failover mechanisms. 
 
Broadcast Manager can be used to monitor Cambria Live target 
errors.  The ‘Output Preview’ tab displays the Encode / Network 
health indicators for every Cambria Live instance.  In addition, a 
notification can be setup on the Broadcast Manager to send an 
email due to an ‘Program / streaming error’.    

9387 



 
Programs  
(Error 
handling) 
 

Programs that are running on machines that have been 
disconnected from the Network are not handled by BCM 
when the machines are reconnected 
 
When the original Live machine running a program is disconnected 
from the network, after a 30sec timeout this will trigger BCM to 
reassign the program to another Live machine.  However, if the 
original Live machine is reconnected, BCM will not automatically 
stop the original program.  

10165 
 

Programs 
(YouTube 
Program 24+ 
hours) 

Programs using the unlimited duration setting must be 
manually stopped from the Programs tab  
 
When streaming to YouTube Live programs that are longer than 
24-hours, the ‘Unlimited Duration’ setting should be used.  
However, when this setting is used, Cambria Live will not 
automatically stop streaming to the YouTube program.  The user 
must manually select the ‘Stop Now’ option for the program from 
the Programs tab.    
 

9497 

Programs 
(YouTube) 

Cannot re-edit the stream type of a YouTube program 
created by BCM  
 
Once a YouTube program is created by BCM, the target resolution 
cannot be modified due to an issue with the YouTube API.    
 

12571 

Programs UI / 
Machines 

Program may run on a Live machine that is not 
Connected/Active 
 
This issue can occur if a user disconnects the Live machine from 
the Broadcast Manager simultaneously with a program being 
assigned. 
 

9495 

Machines Disconnected machines may take up to two minutes to 
reflect the current status in the machines list 
 
When a machine is disconnected from the network or IP changes, 
it may take up to two minutes for the machines list to update the 
machine’s status.  In addition, the old machine entry will remain 
until it is manually deleted from the list. 
 

9345 

Redundancy YouTube Account Manager credentials are not duplicated to 
the backup Broadcast Manager   
 
YouTube Account Manager credentials are not duplicated to the 
backup Broadcast Manager.  If the backup machine is promoted 
to the primary Manager, it is required to input the credentials 
again when creating a new YouTube Live program from the 
Programs tab.  
 

9323 

Redundancy Redundancy may not work correctly if IP address of the 
Primary and Backup Manager machines change or if the 
machine is set to ‘Primary’ before connecting it to the 
network.  
 
Workaround:  It is recommended that static IP addresses are 
configured for the Primary and Backup Manager machines before 
redundancy is configured.  Make sure to also set to ‘Primary’ 

9408, 
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when the machine is connected to the network. 
  

Redundancy Backup machine will be set to the ‘Stopped’ role if the 
machine is shutdown 
 
When the machine is started back up it will remain in the 
‘Stopped’ role. 
 

10172 

Redundancy 
 

BCM ‘Stopped’ role causes PostgresSQL database to be 
stopped 
 
If BCM machine is set to a ‘Stopped’ role (including the Primary 
machine set to ‘Stopped’ through known triggers), the 
PostgresSQL database will also be stopped on that machine.  This 
can cause problems with installation of other software that uses 
the same database (File Convert and Cluster). 
 
Workaround: Make sure to manually set the redundancy role to no 
backup.  Or contact Capella for steps to resolve this.    
   

10668 

Redundancy Redundancy connection light can remain green, even when 
Backup BCM is uninstalled 
 
When BCM is uninstalled on the machine ProstgresSQL is not 
uninstalled, this is by design.  However, because of this the 
redundancy connection will appear to the Primary BCM as working 
normally.   
  

10071 

Monitoring No automatic warning is given if email settings are 
incorrect 
 
Recommendation:  After configuring email settings in the 
Monitoring tab, please use the “Send Test” button to test if the 
settings are valid.   
 

9358 

Options Do not launch if source availability fails behavior 
 
A program is expected not to start if ‘do not launch if source 
availability fails’ option is being used and that condition is met.  It 
is also expected that the program will start if the ‘do not launch if 
source availability fails’ option is unchecked before the end time of 
that program is reached. 
    

9521 

Options 
(Cambria 
Live) 

Broadcast Manager has control of any Cambria Live 
instance that is running on the machine 
 
Broadcast manager has control of any Cambria Live instance 
running on a particular machine under any of these conditions: 
 
1) Cambria Live is originally launched by Broadcast Manager 
2) Cambria Live side option setting ‘Allow Broadcast Manager to 
Control This Machine’ is checked. 
 
Broadcast Manager (BCM) controlled Cambria Live instances can 
be stopped/killed at any time. This includes instances that have 
been “Unlocked” by bypassing the lock screen for the instance. 
“Unlocking” the local Cambria Live instance, will allow for an 
additional level of user interaction with the Cambia Live instance, 

9554,  
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but it does not relinquish BCMs control over the instance. 
 
Workaround:  If Cambria Live is intended to run without 
interference from Broadcast Manager, start the Cambria Live 
manually (locally), and uncheck ‘Allow Broadcast Manager to 
Control This Machine’. 
 
Note:  BCM will try to close whatever Live standalone instances 
on the client machines, 6 minutes prior to the scheduled program 
start time.  The Live standalone instance will have the option to 
postpone, through a UI popup message.  Postponing will allow the 
standalone instance to remain active for another 6 minutes.  
  

Windows 
Configuration 

Disable Microsoft Window’s Hibernate/Sleep mode 
 
Cambria Broadcast Manager and Cambria Live does not support 
Microsoft Window’s Hibernate/Sleep mode.  Broadcast Manager 
will not be able to use the Cambria Live client machine if it is in 
Hibernate/Sleep mode.  In addition, capture card hardware 
drivers and other 3rd party modules may not support 
Hibernate/Sleep mode and can cause other unwanted issues. 
 
Recommendation:  Disable Hibernate/Sleep on the Cambria Live 
machine: 
1. Go to Control Panel>Power Options 
2. For the selected preferred plan, select ‘Change plan settings’ 
3. Select ‘Change advanced power settings’ 
4. Go to Sleep>Allow hybrid sleep 
5. Change the setting to “On” (this change will disable the 
Hibernate option in the start menu) 
6. Go to Sleep>Hibernate after 
7. Change the setting to “Never”  (this change will keep the 
system from Hibernation when it sleeps) 
 
Note regarding Hybrid sleep and automatic reboot feature:   
When Hybrid sleep is used in Windows 10, machine will actually go 
into sleep mode (or hybernate).  This will affect the automatic 
rebooting feature that is part of Live/BCM.   During machine is 
being in sleep/hibernate state, since machine is not running, it will 
not be counted as machine up time. 
So, if user wants to restart machine on certain days of the week 
the machine should be kept up without sleep or hybrid sleep.    
 

3764, 
12875 

Windows  
Configuration 

Changing computer clock forwards causes licensing not to 
work for a period of time 
 
Changing the computer clock forwards beyond actual real world 
time can affect the duration of the license validity when you clock 
is rolled back.  If you are running into an issue with the dongle 
license, please contact Capella. 
 

6111 

Windows 
Configuration 

Redundancy requires machine clocks on the Primary and 
Backup Manager to be in sync 
 
Recommendation:  If both Primary and Backup Managers are not 
part of a domain, configure Windows to synchronize with Internet 
time server to avoid problems with redundancy.  By default 
Windows is already configured to with this “on”.   
 

9395 



If the machines are part of a domain, where Internet time sync is 
not available, the machine clocks will sync to the domain clock.  
This is not a problem.  However, it does imply if both Primary and 
Backup Manager machines are in a domain, they must be in the 
same domain.          
 

Compatibility  
 

Cambria Broadcast Manager cannot be installed on the 
same machine as Cambria File Convert or Cambria Cluster 
Manager  
 
An error message will appear and installation will not continue. 
 

9328 

Compatibility Cambria not compatible with VirtualBox / VMware 
 
Cambria Live and Cambria Live Broadcast Manager are not 
compatible with (VirtualBox / VMware Workstation / VMware 
Player). Cambria Live machines installed with any of these virtual 
machine software may cause them not to show up in Cambria Live 
Broadcast Manager's Machine List properly. Those Cambria Live 
machines may not be able to stream programs. Note that the 
products need not to be installed in virtual machine to cause such 
issue.  It is merely the existence of (VirtualBox / VMware 
Workstation / VMware Player) software in the machine that causes 
the issue.  
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